
WineBase for Windows
This Contents page contains a list of all Help Topics available for WineBase. For information on 
using Help, choose How to use Help from the Help menu or press F1. To return to this page at any 
time click on the Contents Button.

WineBase as a straight database program is easy to use, but if you wish to take full advantage of 
all its features, you will need to consult the User Guide. This help file contains enough information 
to get you up and running. It is not a substitute for a User Guide which is why one is included with 
the program. This file contains answers to the questions that you will no doubt be asking yourself 
when you first use WineBase.
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About WineBase

History.
WineBase is written by Ken Tripp and and first saw the light of day in June 1992 as 
version 1.1. I wrote the program for my own use and it has since developed with the 
feedback of an ever increasing number of user's, into a program that is suitable for 
anyone needing to keep track of their wines.

Tools Used.
Early versions of WineBase were written in TPW (Turbo Pascal for Windows) and the 
current version is written using Borland Pascal 7.0 from Borland International. All 
resources were created using the tools that come with these packages.

The User Guide and this Help file were written using Word for Windows from MicroSoft 
Corporation, and the Help File was compiled using HC31, also from MicroSoft.

Copyright and trademarks.
WineBase is a registered trademark of Ken Tripp.
TPW and Borland Pascal are registered trademarks of Borland International Inc.
Word for Windows and HC31 are registered trademarks of MicroSoft Corporation.



More than just a Data Base

There are many methods that can be used to store an inventory on what wines you 
have. A Ledger Book has been the most common for a number of years, but the use of 
computers for this function is becoming more common.

Computers offer a number of advantages over a book, not the least of which is the 
ability to quickly search for a wine or group of wines. Spreadsheets and general Data 
Base programs have been used by the more intrepid wine collectors for years, and 
recently a number of specialised wine data base programs have come onto the market.

WineBase takes the idea of a specialised data base program a bit further and offers 
features that you are unlikely to see in any other package (until they catch up). Any 
program can keep an inventory, but as we all know, knowing what you have is only the 
tip of the iceberg in Cellar Management.

The most important aspect of Cellar Management is knowing what all those wines are 
doing in terms of Maturity.

It's in the area of Wine Maturity, and the ease of which this information can be displayed
that WineBase shines. The ability to show graphically the maturity of every wine in the 
cellar, to set future Tasting dates for every wine and have the program remind you of 
wines that need your attention, all help make managing a cellar a much easier task.

WineBase also includes a substantial amount of reference material on wine regions 
around the world, with cross reference files linking Wineries to Regions for several wine 
producing countries. The Wines and Wineries of Australia and New Zealand are covered 
in detail. Detailed Winery information, including address details are provided for nearly 
600 Australian Wineries, Maps are included for the main growing regions, and the 
GoldBook for WineBase provides vintage information on nearly 10,000 wines.



Before you get too involved

Before you start entering the wines in your cellar into WineBase there are a couple of 
things you need to do ...

Preferences.
WineBase has two User Defined fields called User1 and User2. You can define the Titles 
for these and you might wish to take some time at this point to set them up to best suit 
your needs. Both these fields can be Searched on and used as a Sort key. The default 
values are Type and Food, but other suggestions include Shipper, Ranking, Rating etc.

You can also set the Date format and Currency Symbol.

The Preferences Dialog is available via this  button and can also be used to set the 
Dialog Colours.

Dialog Colours.
Only a small matter, but you can change the background colours of all the Dialogs WineBase
uses. A selection of 8 designer colours is available, including the standard Borland metal 
grey.

Fonts.
WineBase uses the standard Times New Roman Windows font. Depending on your 
monitor resolution, you may wish to select one that is clearer to read. You can change 
the Font from the Options / Preferences menu.

Cellar Mapping.
If you plan to use the Cellar Mapping functions, then you need to define your cellar 
layout, BEFORE adding wines. You can do this from the Files \ Cellar Rack Designer 
menu.



What do all these buttons do ?

At first sight the numerous Menu choices and the bewildering array of Buttons may lead 
to some confusion, or at least some serious questions about what they all do.

The bar of buttons is called a WineBar, and there are two of them.

You can toggle between the two WineBar's by clicking on the first button  on each 
WineBar.

The first WineBar which is shown when the program begins contains all the Editing and 
Search functions.

The second WineBar has all the Reports, Graphs and Tables on it.

Hint Text.
If you left click on a button and hold the mouse button down the Status Line will display a 
description of what that button does. If you do not wish to execute that function, move the 
mouse pointer off the Button, whilst still holding the button down.



Left Click / Right Click !

It might seem obvious to state that a Windows application is mouse orientated, but it is 
possible to run most Windows applications from the keyboard. Not so with WineBase, 
this program uses the mouse for just about everything, and it uses both mouse buttons. 
Left clicking or Right clicking on the same spot can have very different outcomes.

The two places this is most obvious is in the INDEX listing and on the MAP of Australia.

INDEX
An Index listing is simply the result of any search. Each wine found is listed in a one line 
summary. This Index is like a book index in that its a list of what's available. In order to 
see more details you have to go to the Page Display.

LEFT CLICK    >..Show Page Display

You do this by Left Clicking on any listed wine, anywhere on the line, with a few 
exceptions in the following columns.

Vintage: Mouse pointer = Hand, and clicking here leads to a Menu of all functions.

Stock: Mouse pointer = Bottle, and clicking here leads to the Quick Drink Dialog 
which allows you to quickly reduce the stock count by one.

Location: Mouse pointer = 4 Directions, and clicking here will display the Cellar Map
for that wine.

Maturity: Mouse pointer = Hand, and clicking here produces the Tasting Schedule 
Dialog which is used to mark wines for tasting (checking) at a certain date.

RIGHT CLICK    >    Edit an existing Wine

Right clicking anywhere on the line leads to the Main Edit Dialog, where you can 
modify any details.

MAP OF AUSTRALIA
The Map of Australia is an index to the region maps and regional details Dialog. You can 

get the Map of Australia by clicking on this  button. It can be found on the right 
hand end of the Graphs WineBar. Moving the mouse pointer over this map will cause the



Arrow to change to a Hand or a Hand in a Frame when you are over a green coloured
wine district.

.

HAND    LEFT CLICK    >    Region Details

This Dialog lists the region, details on it and all the wineries in the area (that I have data 
on). At present there are 597 Australian wineries listed.

HAND IN FRAME    RIGHT CLICK    >    Region Map



Wine Maturity and WineBase

Every wine maker has a system by which they can rate the cellaring ability of the wines 
they produce. Most supply these figures which in their barest form might only have a 
best year for consumption (or a range of years). The more fastidious will supply figures 
that inform you whether the wine is too young, improving, in decline or very badly in 
decline or supply a Maturity Curve.

The latter is the system that I have adopted for WineBase and there are four levels of 
maturity, which are derived from the Vintage, the date at which the wine is drinkable 
(GoodFrom), when it reaches the midpoint of its maturity (BestAt), and an upper limit 
on how long it could be expected to keep for (GoodTo).

Each level of maturity is given a name and represented by a colour.

YOUNG To young to drink.
IMPROVING Improving and then levelling off into the stable period
MATURE In its stable period but ultimately heading for decline.
DANGER Past its life expectancy.

These colours are consistent throughout the program, and when displayed graphically 
provide an easy way to see what is happening with every bottle in the cellar.

How you use the figures supplied for a particular wine depends not only on the form that
they are supplied, but the way in which you are going to use WineBase.

Lets take for example a wine of 1989 vintage, bottled and released in 1991 and with a 
general recommendation that it will be at its best in 1996.

Using the general rule that a wine improves for the first third of its life, is stable for the 
next third and then spends the last third in decline, and assuming that the BestAt date 
will be in the middle of the stable period, we can derive a figure for the GoodTo date by 
adding the difference of the Vintage and the BestAt date, which in this case is seven 
(1996 - 1989 = 7). The GoodTo date is therefore 1996 + 7 = 2003.

The GoodFrom date is open to discussion, but I tend to take the viewpoint that a wine is
released when it is drinkable. It might not be very good and it certainly will not be at its 
best yet, but it could be opened. Therefore I use the release date (or shortly after) as the
GoodFrom date. This is not an important figure for the program, so don't trouble 
yourself too much about it.

The crucial figure for WineBase is the BestAt date, as this is the basis of a lot searches. 
I say the basis, because even though you can search for wines that peak (even though 
they don't) in a particular year, you can also search for a spread of years based on this 
figure.

You can determine the BestAt date in a number of ways.

1. Using general recommendations based on the grape variety(s) used.
2. Halving the period that the wine maker says the wine will cellar for.
3. Use a guide supplied by others.

You should also look at When is a wine suitable to drink ?





When is a Wine suitable to drink ?

Wines suitable to drink NOW, (and how to find them).
WineBase has a search function that finds all wines suitable to drink this year. It is 

assigned to this button  on the WineBar.

As already stated, picking just one year as the best year for a wine is a bit fine, so Winebase 
includes the ability to use just the BestAt date or a range of years based on the BestAt date 
and the spread between the GoodFrom and GoodTo dates.

ie A red wine with a cellaring potential of 20 years will have a bigger spread than a white 
wine with a useful life of only 5 years.

You have a choice as to how you set this up.

The Options menu has a selection called 'Best At' Tolerance, which has three further 
selections of Single, PlusMinus and Auto. The default is an Auto setting, but you can use 
just the BestAt (Single) date or the BestAt date plus or minus one year (PlusMinus).

The range of years is shown graphically on the Page Display of a wine, by a row of 
glasses under the maturity graph. Any wine where the current date line intersects the 
glasses is deemed to be drinkable, with the Auto setting giving the best indication.

The 'Best at in Future Years' graph .
This is another area where the spread of years that a wine is drinkable has to be considered. 
This graph uses the BestAt date to determine how many Wines and Bottles will be at their 
'best' in future. Because it uses a single year and ignores the fact that a red wine 'at its best'
in the year 2000, with an expected life of 25 years, will be just as suitable a couple of years 
before and a couple after.

So it is possible to have two towering peaks at say, 2004 and 2006 with an apparent hole at 
2005. That hole might not be there, in fact I guarantee it isn't, because with so many wines 
'at their best' each side of it, most will be just as good the year after or before, so filling the 
hole.



Adding a New Wine

The Main Edit Dialog
To add a new Wine to your cellar select Edit / Add a new Wine from the menu bar or 

click on the  button on the first WineBar. The Main Edit Dialog will appear and you 
can enter details for the wine. Clicking on 'Save this Wine', will as the name suggests, 
save the current information in the dialog. It will not however, close the Dialog. When 
you have finished adding wines, you can exit this dialog by selecting the 'Finished 
Adding Wines' or 'Cancel' buttons.

Use the TAB key to move around, as ENTER saves the wine.

Fill Vintage in first then the Variety
If you fill in the Vintage field, followed by the Variety, then the Good From, Best At, and 
Good To dates will be filled in with default values for that wine. These are only a rough 
guide. Edit to suit your needs. If you change the vintage , the Good From, Best At, and Good 
To dates will be updated.

To select a Variety use the scroll arrows to browse the list and left click on the required 
one. The list contains the 33 predefined types and any that you might have added. The 
selected choice will appear above the List Box. You cannot directly edit the Variety edit 
field.

Adding a new Variety
Under the Variety list is a button marked Add New Variety, if you click on this the Add 
Variety Dialog Box will appear. You can enter any type you like in the Edit Box. Click New 
Variety to place your selection in the Variety Edit Box in the main Edit Screen. The List 
Box is also updated, but you must save the file with this Variety to store it.

With any custom Variety that you enter the Good From, Best At, and Good To dates will 
be set at default values of 2,3,5. Edit these based on your (or someone else's) 
knowledge of that wine.

Non Vintage Wines
Next to the Vintage scroll arrows is a button marked Non Vintage. When clicked, 9999 
is placed in the Vintage, Good From, Best At and Good To date fields. This signifies that 
the wine has no vintage (ie a fortified wine that has no definite shelf life) and is treated 
as such in all Listings, Graphs and Tables. In the scrollable display screen wines of this 
type are marked as NVin (which is shown in blue, as is the Age box). In graphs and 
tables there is a separate column on the left hand side marked Nv. In the full screen 
display mode the vintage will be listed as "Non Vintage" and there will be no ageing 
graph shown.

Drop Down Lists
The Winery, Label, Region, 'User1', 'User 2', and Cellar Position Edit Boxes have 
drop down lists containing all current entries on file. Clicking on any of these will place it 
in the Edit Box. 

Finding a Region



WineBase now has Winery to Region cross reference files. Two buttons next to the 
Region field access this. If you enter a Winery and then click Find, the Region will be 
placed in the region field. List will list all the Wineries and Regions, selecting one will 
place it the respective field.

Other Fields
Clicking on Add Date adds the current system date in the Purchased field.

1 case = 12 Bottles. Default bottle size is 750 ml. Maximum bottles = 255.
Total Stock is made up of Bottles and Cases.    43 Bottles Total Stock = 3 Cases and 7 
Bottles.

Enter the Price and Value with a format of $9999.99    The program strips off the dollar 
sign and decimal point for calculations, but it displays what you enter when listing 
wines. The default value is $10.00 and you can change this in one Dollar steps by using 
the scroll arrows. The button next to the scroll arrows enters a price of $0.00, which is 
listed in displays as ?

History, Notes, Tasting and Map Buttons
When adding a Wine, these buttons are greyed, and cannot be used, until you click on 
Save this Wine. A Dialog will then appear that lets you edit these files. When you have 
finished, click on Exit, which saves the current Wine.



Editing a Wine

Before you can Edit a wine you must first find it and list it in an Index. An Index listing is 
the result of any search and it is from here that you View or Edit a Wine. To list your 

entire cellar you can click on this  button or perform a selective search using this 

 button.

After deciding what type of search you wish to make ie 

All wines,
All improving or 
All Cabernet Sauvignon's from The Hunter Valley etc. 

and performing that search, you will end up with a list of Wines in the Index (providing there 
are some to find).

To Edit a wine Right Click anywhere on the Wine you wish to Edit. 
This leads to the Main Edit Dialog.



Deleting a Wine

You can Delete a wine from the Page Display for that wine (ie after Left clicking on an 
Index entry), as this Window has a menu choice called Delete. You will be asked whether
you really wish to do this. There is no UNDO on this function.

You do not have to delete wines that have no stock.

'Lost Souls'
All Wines that no longer have any Bottles are called Lost Souls. Lost Souls will not show 
up in Graphs, Tables or the Health Report. So it doesn't matter if they exist. Lost Souls 
can also be used to set up wildcard search fields for your genuine wines. You can search 

for Lost Souls using the Search by Stock Level button  and selecting 'Lost Souls'.



Your Cellar, Sample Cellar and Winery Files

WineBase stores information on a number of Cellars, all of which you can Edit

Your Cellar.
This is the main data file in WineBase and contains the information that you enter into 
the program, and consists of eight data files ...

WINEBASE.DTA Main data file.
WINEINFO.DTA Your information sheet.
NETWORTH.DTA For Value and Stock graph.
WINENOTE.DTA Comments file for each wine.
SCHEDULE.DTA Tasting Schedule for each wine.
MAPFILE.DTA Cellar Mapping for each wine.
MYCELLAR.DTA Rack layout file.
RACKFILE.DTA Cellar rack definitions.

In addition to these files you can attach a Text File of up to 8000 characters for each 
wine for detailed Tasting Notes, Scores etc.

Sample Cellar.
A small Sample Cellar is included so that you can look at some of the features of 
WineBase. You can access the Sample Cellar from the File Menu and have a play with the
Search and Sort options, as well as look at some of the Graphs and Tables 

Winery Files.
Data files supplied by Wineries as a source of information on their products. Yes I know 
there aren't many Winery Files, but we all live in hope that the Wineries will start to see 
the benefit of providing this information.



The files that make up Your Cellar

Each wine has a Main Data File which stores the basic information on each wine.
There are also other files that are attached to this Main Data File.

Comments.
Eight lines of comments for each wine. This is for short notes, as each line is limited to 
50 characters. Comments are printed along with the other information on a wine when 
you select Print from the Page Display. If you need to add more detailed comments you 
can attach a text file of up 8000 characters (a couple of A4 pages at least) to each wine 
by selecting Text File from the menu in the Page Display

Tasting Schedule.
Eight lines of Dates and Comments. The Date consists of Month and Year in a numerical 
format. In conjunction with the Comments field these are used to mark a wine for tasting
at a certain date in the future.

Text File.
You can also attach a text file to each wine. This is a standard ASCII text file that can be 
edited within WineBase or on any word processor. Each file is named with a format of 
WINE????.TXT, where ???? is a 4 digit number that identifies the wine in the Main Data 
File. The file can be up to 8000 characters in size, and you can Cut and Paste between 
the Windows Clipboard and this file.

Cellar Map.
Which provides a graphical presentation of Your Cellar, and shows where the wine is.



Printing

Fonts
WineBase uses True Type fonts, with the default font being Times New Roman. The same
font is used for display to screen and printing. You can change the font from the Options 
menu by selecting Fonts.... The clearest fonts seem to be Arial and Times Roman. Bold 
works well. Size is ignored.

Index Listings
You can print any Index listing, by selecting Print from the Index Menu.

Page Display
You can print the Page Display for a wine, by selecting the Print menu option. The 
General Notes and the Tasting Schedule are also printed at the bottom of the page.

Graphs and Reports
When displaying any of the Graphs and Reports (assuming you are using the WineBar) 

the Printer  button will be surrounded by a Green band if that Graph or Report can 
be printed, and a Red band if it cannot. Click on this button to print the currently 
displayed Graph or Report.



Common Questions (and answers)

Q. How do I get more information than this Help File?
A. Read the User Guide !!!

Q. How do I add a new wine to the cellar?

A. Click on the  button on Main WineBar.

Q. How do I remove one bottle of wine, quickly?
A. List the wine in an Index Listing. Left Click on the required wine, in the Stock column. Click
on 'Remove one Bottle'.

Q. Can I add detailed tasting notes and scores to a Wine?
A. Yes, you can attach a text file to each wine, that can have up to 8000 characters (4-5 A4 
pages) in it.

Q. Why does the Winery Distribution graph only list 60 Wineries?
A. The distribution graphs are limited to 60 entries.

Q. How do I see the other WineBar?

A. .Clicking the first button  on each WineBar, will show the other one.

Q. How do I view the Sample Cellar?
A. .Select Sample Cellar from the Files menu.

Q. How do I get back to My Cellar?
A. .Select Your Cellar from the Files menu.

Q. Can I view all the wines in my cellar? How?

A. .Yes. Click the second button  on the Main WineBar.

Q. How do I get a print out of my wines?
A. .Just about everything that is shown on the screen can be printed.

Q. How do I view the winery maps?
A. .Click on the Map of Australia  button, and then Right Click on a region.

Q. Can I get a print out of the regional maps?
A. .No.

Q. How many wines and wine varieties can I enter into WineBase?
A. .WineBase is limited to displaying 1170 different wines.

Q. How do I delete a wine?



A. .From the Page Display, select Delete.

Q. How do I edit a wine?
A. .List it in an Index, and then Right Click anywhere on the line showing that wine.

Q. How do I view the cellar racks?
A. .From the View menu, select Map of Cellar Racks.



WineBar
Most Windows programs have a row of buttons underneath the Menu Bar. These are usually 
referred to as a ButtonBar, ToolBar or SpeedBar and they provide a short cut to the most 
commonly used functions.
In keeping with the nature of program, I have called the row of buttons in WineBase a 
WineBar.



Status Line
The Status Line is the grey band at the bottom of the WineBase Window. It displays useful 
information, such as what screen you are looking at. When you are in certain screens, the 
right hand side of the Status Line will display options available when you click the left or 
right mouse buttons.



Mouse Buttons

Most mice  have two buttons, some have three. Two button mice are the most common as
Windows does not support the middle button.
Left click means pressing the Left button and Right click the right.



Ultimate
A bold claim that I am willing to defend, because in the course of writing this program, I 
have come across a number of Cellar Management programs (some costing a great deal 
more), and I have yet to find one that offers the range of facilities and ease of use that 
WineBase does.



WineBase
The Ultimate Cellar Management System.



Page Display
A one screen display that shows all the details about a single wine, including a nice graph 
showing the wines Maturity Curve. You can also view the Comments and Tasting Schedule 
from here, Print the contents of the screen, View or Edit an attached text file, or Delete the 
wine from the cellar.



User Guide
A well written (hopefully) and concise guide to using this program and achieving the most 
from it. Straightforward explanations on how to perform all the functions that WineBase 
offers, interspersed with lots of diagrams and pictures, and an ample amount of white space.



Maturity Curve
A curve that starts at zero, rises gracefully to a maximum value, and hopefully holds that 
value for as long as possible, or takes twenty years to get there. This is plotted against time,
with the maximum value being considered as the best time to drink the wine.
To draw a graph with gentle curves is a bit hard to achieve, so what we have in WineBase is 
something that looks like an Aztec Pyramid when viewed from the side. It rises, flattens off 
and then falls, with each stage covering the same amount of years.



Mark
An empty Comment filed is used to mark a wine to be tasted at a future date, or to find all 
wines where the tasting date has passed and no comment was entered. You either didn't 
taste the wine or forgot to enter any comments.
Only enter a Comment when the Month and Year is reached and the wine Tasted.



Lost Souls
A wine that you used to have, but now alas, the last bottle has been consumed. Wines with a
stock level of ZERO do not get deleted from WineBase, they stick around, in the vain hope 
that one day you will acquire more of them.
This saves you having to enter the wines information again, if in fact you do buy more. If you
are never going to replenish the stock, then you can delete the wine via the Page Display.

You can Search for Lost Souls using the Search by Stock Level  button.



Peak
Quality wines do not peak in a single year, rather they enjoy a period of years in which they 
are at their best. There are wines however, that are produced to drink as soon as they are 
released, and have a limited shelf life after that.
In order for WineBase to work, you have to nominate a single year for BestAt. If a wine is 
released and the wine makers recommendation is that it will benefit from cellaring for 
between 4 and 8 years, then the BestAt date would be Release Date + 6 years. The GoodTo 
date would then be Release Date (or Vintage) + 12.
Wines that are meant to be drunk immediately can have the BestAt date set to Release Date
+ 1, and a GoodTo date of Release Date + 2.



A few details about the Author
Born in 1956 in Melbourne, Victoria, Australia.
Currently living in Black Rock, a quieter area of Melbourne, 18 km SE of the city centre, on 
the Eastern side of Port Phillip Bay. A stones throw from the beach, in an area that has some 
of the best golf courses in the state.
Had my first exposure to computers when I started an Electronics Engineering Degree 
course at R.M.I.T. in 1974. Programmed in FORTRAN, ALGOL, PL/1 and PL/C on a ICL 
mainframe and later a CYBER 76. Learnt Pascal some years later on a Commodore 64 would 
you believe, then on a PC, moved to C on PC's and later to C++ when Windows came into 
being. I currently use Borland Pascal, which for the lone developer or small teams is beyond 
doubt the best language around. I have worked in the Computer Industry for a number of 
years as both a Technician and a Programmer.
I try to write software that never leaves the user wondering 'What do I do now?'
The interest in wine started in my teenage years, due to spending too much time with an 
Uncle whose sole interests in life seemed to be playing golf and drinking fine wines. I have a 
modest collection of wines in my cellar, and as expected, I keep track of them all with 
WineBase. I am a member of the Australian Society of Wine Educators, but as yet have no 
formal 'wine' qualifications.
I do however, know what I like to drink.
Other interests include music, and the equipment needed to reproduce it, sailing yachts and 
sailboards (slalom), bike racing and rallying (only watching these days).



Australian Society of Wine Educators

 The Society is an incorporated non profit educational organisation dedicated 
to the encouragement and improvement of wine education. Membership is 
open to those that teach about wine, or are involved in the business of wine, 
or those consumers who have a genuine interest and involvement in wine and 
wine education.
For more information and an application form, please address enquires to:-

Australian Society of Wine Educators
Wine Industry House
555 The Parade,
Magill, S.A. 5072
P.O. Box 647, Magill, S.A. 5072
Tel. (08) 364 1122
Fax (08) 364 4489

Where were we?



Commodore 64
A much maligned beast, relegated in most people eyes to the role of playing games.
From a programmers point of view, a very versatile machine that would let you do almost 
anything.
Where were we?



Golf
For the uninitiated, a seemingly pointless game, which involves trying to hit a small white 
ball into a hole, using an implement that appears totally unsuitable for the task.
For those of us that play the game, the time spent on the golf course often reduces the 
known world, and our thoughts about it, to nothing more than an expanse of grass bounded 
by some trees.
Wine does not travel well in a golf bag.
Where were we?



GoldBook
The GoldBook for WineBase is an electronic version of the current edition of Robin 
Bradley's Australian and New Zealand Wine Vintages. This book has been recognised as the 
definitive reference source for nearly 14 years and is known to most as the GoldBook.

300 or so of the better wineries and the wines they produce are listed, with an overall rating 
and individual ratings on nearly 10,000 wines. The best year for drinking is provided along 
with the current value.

The GoldBook is accessed via this  button, the Main Edit Dialog, or the Australian 
Regional Information Dialog 

.



Print Graph Button
Its a good thing that we're not in WineBase, or the currently displayed Graph would be 
making its way to your printer.



Rallying
Driving at ridiculous speeds on public roads, normally in a Forest, usually in the middle of 
the night.
Where were we?



Forest
A place where trees grow, birds chirp, bears ___, timber cutters cut, protesters protest, and 
maniacs drive cars at speeds that are illegal on bitumen roads.
Where are we?



Where are we?
If you were in a forest in the middle of the night, there's a good chance you could be lost.
Back to where we first started



Page Display
The Page Display screen for the selected wine.
The complete details of a wine and the Maturity Curve.



Main Edit Dialog
You can Edit any details about the selected wine via this Dialog



Quick Drink
A feature we all like to use.
Removes ONE bottle from the total stock of the selected wine.



Cellar Map
Displays a Cellar Map for the selected wine.
If the wine is not mapped this option will be greyed.



Tasting Schedule
Displays the Tasting Schedule Dialog.



Exit this Menu
Closes the Popup menu.



Toggle Button
As if by magic, all the Buttons on the WineBar change.
Actually, the other WineBar is shown.



A Button
Just a pretty picture, but in WineBase its a quick way of performing a function.



Details
All the Wineries in this area are listed, with full address information.



Map
There is a detailed map for this region.



Toggle
Show the Graph, Table, Report and Map WineBar.



Index
Lists a one line summary of all wines in the cellar.



Search and Sort
You can define what you wish to Search for and Sort order.



Multiple Field Seach
Search with any combination of User1,User2, Region, Vintage, BestAt and Variety.



Add a Wine
The Main Edit Dialog where you can enter a new wine.



Search by Stock Level
For finding single bottles, 'Lost Souls' or wines you have a lot of.



Wines to Drink
Lists all wines that are in the middle of the Maturity curve and are therefore suitable to 
drink.



BestAt in Future
Lists all wines at their best for each of the next 20 years. This gives you a good idea of what 
you will have to drink for the coming years.



Tasting Schedule
Find wines due for Tasting in 3 month blocks, each month for the next 2 years, or wines that 
have missed being tasted.



Non Vintage
Lists all Non Vintage wines. These include fortified wines and Champagne.



Young
Lists all Young wines (these are too 'Green' to drink yet).



Improving
Lists all wines that are still Improving. Towards the last stages of Improving, a wine should 
have stabilised.



Mature
Lists all wines that have passed the BestAt date and are therefore Mature.



Danger
As the name suggests, wines in this category are at the end of their life, and should have 
been drunk by now.



Backup
Copies your data files to a floppy disk.



Preferences
You can define User1, User2, Date Format, Currency, Dialog Colours etc from here.



Winery to Region
Major wineries from the main wine growing areas of the world, with details of where they 
are.



GoldBook for WineBase
The GoldBook search Dialog.



Licence Information
Details on this copy of WineBase and who is licensed to use it.



Help
You're using it now.



Toggle
Shows the WineBar with the Edit and Search options on it.



Summary Report
The Health Graph and Totals for your entire cellar.



Stock and Value
Plots total Stock and Value on a monthly basis.



Ageing Graph
Plots total number of wines in each stage of Maturity for the next 20 years.



TimeLine
Where on the maturity curve is a wine now? This Table shows all the wines in the cellar.



Table
Showing (Winery,Label,Variety) vs Vintage vs Maturity.



Table
Showing (Winery,Label,Variety) vs Vintage vs Bottles.



Table
Showing Variety vs Vintage vs Bottles.



Table
Showing Variety vs BestAt vs Bottles.



Vintage Graph
Plots total Wines and Bottles for each vintage for the last 20 years.



BestAt Graph (all wines)
Plots total Wines and Bottles for all wines in your cellar based on the BestAt date for the next
20 years.



BestAt Graph (by Variety)
Plots total Wines and Bottles for a single Variety of wine in your cellar based on the BestAt 
date for the next 20 years.



Distribution by Winery
Total Wines and Bottles for each Winery. This and all Distribution Graphs are limited to 60 
entries.



Distribution by Region
Total Wines and Bottles for each Region. This and all Distribution Graphs are limited to 60 
entries.



Distribution by Variety
Total Wines and Bottles of each Variety. This and all Distribution Graphs are limited to 60 
entries.



Distribution Graphs
Show Wines only.



Distribution Graphs
Show Wines and Bottles.



Distribution Graphs
Show Bottles only.



Print
If surrounded by a green band you can print the current graph.



Globe
Lists all Maps that are available for display. This is a non scolling screen and is not meant for 
display of regional maps if you are using 800 X 600 resolution or lower.



Australia
The Interactive Map of Australia, which is an access point to the Regional Maps and Regional
Information Dialog.



Australia
With a land area of 7.6 million sq km, and a coastline of 25,760 km, Australia is the World's smallest 
continent but the sixth largest country, and only slightly smaller than the U.S.A.

Despite having an overall population density of only 2.2 people per sq km, Australia is one of
the most urbanised countries in the world, with most of the population of 17 million people 
living around the coast.
Where were we?




